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What is View2 Plus?


View2 Plus is a unique application add-on designed for the sophisticated Word user.


If you depend on Word 97 for business, education, desktop publishing, or demanding general-purpose editorial, you almost certainly will benefit from what View2 Plus has to offer.


What can View2 Plus do for you?


View2 Plus makes it easy for you to exploit to the full the value of Word’s (MDI) multiple document interface and Windows multitasking environment. It works by working the way you do. 


You need View2 Plus if:


· You find yourself frequently switching document and application windows to compare and edit documents and other windows.


· You want to make detailed comparisons of different documents the way you would with paper documents.


· You want to work in different views or different parts of the same document at the same time.


These and many other window-related tasks are a snap with View2 Plus and the PowerPlus toolbar.
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View2 Plus is self-explanatory and uses dynamic controls and text to guide you. In addition to normal operation, you can select Task List, Window, and File modes—plus Options and the PowerPlus toolbar.


Arranging windows side by side or up and down


( Click the View2 Plus button or choose View2 Plus from the Window menu.


For previewing, selecting, and arranging document windows (including macros and protected documents) side by side or above and below each other. 


What you need to know


· The file name you see above the list box is your active document. It’s also the document that is initially selected in the list box and that appears in the preview box.


· The documents you see in the list box are the same ones you can see at the bottom of your Window menu: they’re listed in just the same order, which is alphabetical.


· When you select a document in the list box, it appears in the preview box with its name above. You can activate this document by choosing Switch To.


· You also see the selected document’s name beneath the list box with the choices about how to display it with the active document. When you choose OK, both document windows appear in the Word workspace.


· By default, View2 Plus arranges documents vertically; you choose to put the document you select on either side of the active document with the Left and Right options beneath the list box.


· Alternatively, you can select Horizontal from the Arrange group and choose to put the document you select above or below the active document with the Top and Bottom options beneath the list box.
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· If you leave your active document selected in the list box, you can choose to maximize it or view it twice with the Max. and Twice options beneath the list box. When Max. is selected the Vertical and Horizontal options are not available.


· There is a three-way toggle button that first lets you arrange all your open documents (View All), then lets you minimize all your documents (Min. All), and then lets you maximize all your documents (Max. All). When you use the toggle button, the dialog box remains open.


Tips
To make any document the active window, select it from the list box and choose Switch To.


To return all documents and their text to normal, open View2 Plus and choose OK.


Arranging windows individually


( Choose Window in the Mode group.


For previewing, selecting and arranging individual documents as half- or quarter-size windows. 
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What you need to know


· The document you select in the list box appears in the preview box.


· You see the selected document’s name beneath the list box with the choices about how to display it. When you choose OK it is displayed according to your selection.


· By default, a document is displayed as a half-size window; you choose to put it on the left, right, top or bottom half of the Word workspace.


· Alternatively, you can select the Quarter option from the Size group and choose to put the document in the top left, top right, bottom left, or bottom right of the Word workspace.


· Check the Keep the Dialog Box Displayed option if you want to select and arrange more than one document window before closing the dialog box. The OK button says Apply instead.


· Choose Show Toolbar to display the PowerPlus toolbar and close View2 Plus. Choose Hide Toolbar to hide the PowerPlus toolbar.


Tip
To keep the dialog box open when you have more than one window to arrange individually, just select the check box.


Arranging Word with other applications


( Choose Task List from the Mode group.


For selecting and arranging application windows side by side or above and below Word’s application window. 
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What you need to know


· The list box displays the applications you have open on your desktop. Word is initially selected.


· When you select another application from the list box, you can activate this application by choosing Switch To.


· You see the selected application’s name beneath the list box with the choices about how to display it with Word. When you choose OK both application windows appear on your desktop (with your active document maximized in Word).


· By default, View2 Plus arranges application windows vertically; you choose to put the application you select on either side of Word with the Left and Right options beneath the list box.


· Alternatively, you can select Horizontal from the Arrange group and choose to put the application you select above or below Word with the Top and Bottom options beneath the list box.


· If you leave Word selected in the list box, you can choose to maximize it.


Tip
To return the Word application window, as well as all documents and their text to normal, open View2 Plus, select Task List, and choose OK.


Managing files


( Choose File from the Mode group.


For opening, closing, and copying files.
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What you need to know


· You can open any file you want with the Open File button. When you open a file it becomes the active document.


· You can close any document window you select with the Close File button.


· You can copy any document you select with the Copy File button. After saving the new file, View2 Plus asks you if you want to reopen the file you just copied.


· You can see the path of any open file. This comes in very useful when you have opened identically name files in different directories and are not sure which one is which.


Tips
To close one window of an open document, choose Close File.


To save a document for the first time, choose Copy File.


Choosing Options


( Choose Options from the Mode group.


For selecting custom settings in View2 Plus and the PowerPlus toolbar, where appropriate.
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What you need to know

· Default Window Choices
Set your choices for positioning document windows when using View2 Plus or PowerPlus toolbar. The default settings are Vertical and Left, which means a selected document appears on the left side. You can change this to Right. If you change the orientation to Horizontal, then the choices become Top and Bottom.


· Display
Choose to show the PowerPlus toolbar and the File Buttons in View2 Plus.


· Zoom
Set the window zoom when positioning document windows with View2 Plus or PowerPlus toolbar. The default is 100%.The range you can choose from is 10 to 200%. Your choice affects all window you view side-by-side or above and below each other. 


· View
Set the window view to Normal, Outline, or Page Layout when using View2 Plus or PowerPlus toolbar.


· Save Settings
Choose this If you want View2 Plus to use the settings you have chosen. If you choose Cancel, View2 Plus will reappear, but the settings will not be saved.


Using the PowerPlus toolbar


( Choose Window in the Mode group and then choose Show Toolbar.


For arranging individual document windows without having to use the View2 Plus dialog box. Also features two more add-ons: Switch Windows and View Double.
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What you need to know


· The PowerPlus toolbar gives you all the functionality of View2 Plus Window Mode and more without having to open a dialog box.


· The PowerPlus toolbar lets you manipulate the size and position of any selected window, including protected and macro documents.


· Like any Word toolbar, you can float the PowerPlus toolbar or drag it to one side of the application window.


· You can choose the Show Toolbar/Hide Toolbar button after choosing Window Mode in View2 Plus or by using the Options dialog box.


· Display On…
These eight buttons give you all the choices for half- and quarter-size windows for a selected document.


· Wrap or Unwrap
Toggles text wrapping and unwrapping for a selected document. 


· Maximize All Windows
Maximizes all windows and unwraps their texts too.


· Switch Windows
Switches windows on the fly as you select the document names from the list. So much better than having to open and reopen the Window menu in Word—particularly when you have more than nine windows open, when Word supplies the pathetic Activate dialog box. You can activate Switch Windows with alt+q.
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· Double View
A cool addition that gives you more than could be packed into View2 Plus. Don’t just display a window with itself—decide which side to put the original and which view to put either window in independently! Brilliant if you want to see a document take shape in Layout or Outline mode as you type or edit in Normal mode.
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Tip
Use the PowerPlus toolbar like a modeless dialog box by floating it anywhere in your application window. 


Frequently asked questions


Word must have something like this?


No. It has the Arrange All command that arranges all your open documents so they do not overlap. The problem with this is that you have no control over the way the documents are arranged. It’s only useful if you have a couple of windows open and, only then, if you’re happy “up-and-down” editing.


Word 6 and 95 did supply a macro in the layout.dot template called ArrangeWindows that has a horizontal or vertical option. (If you have a previous version of Word, you can open layout.dot in Word 97 and test it.)


There are three things about this macro that make it virtually useless:


· It does not let you specify which document windows to arrange.


· It does not wrap the text in each document window for side-by-side editing.


· It does not size the windows properly if the Zoom magnification is less or greater than 100%.


What does View2 Plus do to my documents?


View2 Plus has no effect on the configuration of your Word desktop or your documents. Window sizing and text wrapping are display features that have no effect on the formatting of the documents themselves.


When you arrange documents vertically, View2 Plus automatically wraps the text in each window for easy editing. Here are two questions that people sometimes ask:


What happened to my line numbers?
Word doesn’t show line numbers on the status bar when text is wrapped.


Why do my lines seem longer than before?
Word is wrapping the text to the edge of the window when you’re working full-screen.


Solution:
Run View2 Plus again and choose OK  (when the Max. Option is selected) or click the Maximize All Windows button on the PowerPlus toolbar. 


Remember to do one of these things whenever you’re ready to work full-screen. (If you maximize a window without using View2 Plus or the PowerPlus toolbar that you previously arranged vertically, the text remains wrapped.)


What are some other common ways to use View2 Plus?


· Switch multiple documents or application windows quickly to search and compare information.


· Write in Normal view and, at the same time, see a copy of your document take shape in page layout or outline view. 


· Work in two, four, or more parts of the same document at the same time.


· Use View2 Plus to work with macros and protected documents too.


More Tips


· Word windows “remember” their previous size and position. You may notice that choosing the restore button on a window puts it back to just the same position you set for it in View2 Plus—even after maximizing all your windows. You can use this to your advantage by restoring and maximizing windows without having to reposition them with View2 Plus.


· If you want to wrap or unwrap the text in just one document, use the Wrap or Unwrap button on the PowerPlus button for this purpose.


· Use the power View2 Plus and DoubleView gives you to work in two views of the same document. You’ll find this is far more effective that splitting a window horizontally, where the two panes are not truly independent—for example, switching views or scrolling in one pane affects the other pane. Remember that you are still working on one document—editing in one window is the same as editing in the other.


· If you use View2 Plus when working in outline or page layout view and you have more or fewer toolbars in one of these views than your normal view, the windows will be sized according to this toolbar arrangement. Either they will appear with a gap at the bottom, or the bottom of the windows will be hidden behind the status bar. When you return to outline or page layout view the Windows will be sized correctly. To avoid this problem completely, float the extra toolbar—for example, float the Outline toolbar so its not anchored to the top of Word.


· If you’ve installed Microsoft’s Internet Assistant add-in, you cannot run this program and use text wrapping at the same time. When you run View2 Plus, it gives you the option to unload this add-in till the next time you run Word.
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Installing View2 Plus yourself


Installing View2 Plus and the PowerPlus toolbar yourself couldn’t be simpler. Just copy three files to the folders from which you’re running Word. 


Copy the View2 Plus/PowerPlus template to your Word startup folder


· Put the file V2PWRPLS.DOT, which contains all the View2 Plus and PowerPlus macros, in the Word startup folder (usually office\startup).


· Then restart Word. To test the template is loaded, choose Templates and Add-ins from the Tools menu. Make sure the file is listed and checked.

Copy the View2 Plus help files to your Word executable folder


· Put the files VEW2PLUS.HLP and VEW2PLUS.CNT in the same directory as winword.exe (usually office). 


That’s it!


The View2 Plus/PowerPlus template contains everything you need: all the macros, the View2 Plus toolbar button, menu command and shortcut keys, plus the PowerPlus toolbar.
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